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ORIENTATION

This Electronic Guide file contains hypertext links  to individual article
files.  Links are represented by colored text (e.g., a name or title);
clicking on the text activates the link.

Before you start browsing and using the information on this CD-
ROM, you will need to install Adobe Acrobat Reader + Search 5.0.
If you already have Acrobat Reader installed on your system, make
sure it includes the Search  plug-in.

To install, click on “README.TXT” which contains additional
information.

In many instances, we refer to the “menu bar” and “tool bar”, shown
here for reference.

   menu bar:

      tool bar:

Be sure to read the following on how to achieve the best
performance with this electronic guide.
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In order to take full advantage of the performance capabilities of
this collection, we recommend that you do the following:

1.  To make navigation and searching easier, we strongly
recommend changing the following Acrobat Search
Preferences (found under Edit > Preferences > Search on the
menu bar.) In the dialog box shown for Acrobat Search
Preferences, make the following changes:

A.  Select the “Document Information” option so that Title,
Author, Keywords, and Subject fields are visible when
specifying search criteria.  If for some reason this preference
option is not present on your system, check to see that you

have the Search plug-in installed. The Search icon  will be

present on the Acrobat tool bar if the function is properly
installed. Specifics of the Search function are described later
in this section.
B.  Change “Show first 100 documents” to “Show first 1000
documents”. (Type in “1000” in the field provided.) This allows
the maximum number of hits to be displayed during a search.

These settings will become your new default.

RECOMMENDATIONS FOR OPTIMAL PERFORMANCE
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USING BOOKMARKS

In addition to links, you can navigate through the Electronic Guide
using Bookmarks.  If they are not already visible, choose Window
> Bookmarks from the menu bar or press the “Show/Hide
Navigation Pane” button on the tool bar.  A panel opens on the left
side of the screen displaying Bookmarks in a hierarchy.
Each Bookmark corresponds to a location in the Electronic Guide.
Click on the text in a Bookmark to go to that location.

Entries with lower level Bookmarks show a plus sign (+) when
subordinate Bookmarks are hidden and a negative sign (-) when
subordinate Bookmarks are visible.  To view subordinate
Bookmarks, click on the plus sign (+).  To hide them, click on the
negative sign (-).  Dragging the right margin of the bookmark
panel resizes it. Dragging the Bookmark tab moves the panel to a
different location.
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SELECTING TEXT AND GRAPHICS
To select text or graphics, the appropriate select tool must be
selected. The select tools share the same space on the tool bar.

To see more text selection tools you must click the arrow to the right
of the Text Select Tool. A “flyout” menu will allow you to select the
Column Select Tool.

See the Adobe Acrobat Reader 5.0 Guide (Help > Reader Help) for
more information on these tools.

Text Select Tool Graphic Select Tool
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NAVIGATION BUTTONS

Section Map
The current section is shown at the top of each page. The “path”
to this section is shown at the right.  Clicking these text buttons
moves you to the start of that section.

Next Page
Click to advance to the next page in the section.

Previous Page
Click to go back to the previous page in the section.

(The Page Up and Page Down keys perform the same
functions as the Next and Previous Page buttons.)

Fast Forward Pages
Click to advance (jump) multiple pages in the section.

Fast Back Pages
Click to go back (jump) multiple pages in the section.
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ACROBAT TOOLBAR

Navigation

History

Go to Next View (One Link)
Go to Previous View (One Link)

Go to Last Page
Go Forward One Page
Go Backward One Page
Go to First Page
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Zoom

Zoom Out
Zoom In
Hand Tool

Selection

ACROBAT TOOLBAR

Graphic  Select Tool
Column  Select Tool
Text Select Tool
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ACROBAT TOOLBAR

Page View

Find/Search

Next Highlight (Hit)
Previous Highlight (Hit)
View Search Results
Search
Find

Fit Width
Fit in Window
Actual Size
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PERFORMING A “FIND”
Choosing Find opens a dialog box. Find scans linearly through the
currently open Acrobat file from the cursor forward.  If the Electronic
Guide PDF is open, Find will scan the entire Electronic Guide for
a match to your text.  Type a text string in the field provided, check
the appropriate options and press the “Find” button. Reader then
highlights the first instance of the text string. To look at the next “hit”,
click on the Find icon and press the “Find Again” button in the
Acrobat Find window.

PERFORMING A “SEARCH”
Choosing the “Search” tool bar button or Search menu item (Edit
> Search > Query), opens a dialog box from which you can access
the more powerful full-text search engine (if you installed Acrobat
Reader from this CD-ROM).  Its dialog box is shown on the next
page.

Typing a term in the text box at the top of the Search dialog box and
pressing the “Search” button causes a full-text search of all words
in the body of papers in the collection.  If you have “Document
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Information” active in your Reader preferences, entering a term in
one or more of the fixed fields (Title, Author, Subject or Keywords)
will cause a search for hits in only those fields.
If you are not finding files you think should show in the results list,
Acrobat may not be attached to the correct index file.  To check,
press the “Indexes...” button for a list of available indexes.  If this
collection is not listed, press the “Add...” button and look in the root
directory of the CD-ROM for a file called “index.pdx”.  Click on that
file to add it to the list.
NOTE to MAC users: The version 5.0 INDEX.PDX file is not
compatable with MAC OS X (with either Reader 5.0 or 6.0). A
version 6.0 index.pdx file is included on
this CD-ROM and should be used for full
text searching. voltage

See the Reader Help (on Help
menu) for more complete
instructions on selecting
appropriate options,  constructing
boolean queries, etc.
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Welcome to the 2005 Second Annual IEEE Communications Society
Conference on Sensor and AdHoc Communications and Networks
on CD-ROM. This disc is designed so that you may locate papers by
session or author, as well as with full text search.

The papers were converted to Adobe Acrobat PDF file format for
cross-platform access. The viewing quality will vary with the size
and quality of fonts used. Even though the viewing quality on your
monitor may vary, all papers print clearly.

Be sure to read the “Getting Star ted” section for useful
recommendations on how to use this electronic guide.

Thank you and Enjoy!
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Trademarks

Adobe, the Adobe logo, Acrobat and the Acrobat logo are trademarks
of Adobe Systems Incorporated or its subsidiaries and may be
registered in certain jurisdictions. Macintosh is a registered trademark
of Apple Computer, Inc. HP is a registered trademark and HP-UX is
a trademark of Hewlett-Packard Company. Motif is a trademark of
Open Software Foundation, Inc. Solaris is a registered trademark of
Sun Microsystems, Inc., Sun and OpenWindows are trademarks of
Sun Microsystems, Inc. SPARC is a registered trademark of SPARC
International, Inc. SPARCstation is a registered trademark of SPARC
International, Inc., licensed exclusively to Sun Microsystems, Inc. and
is based upon an architecture developed by Sun Microsystems, Inc.
UNIX is a registered trademark in the United States and other
countries, licensed exclusively through X/Open Company, Ltd.
Windows is a trademark of Microsoft Corporation.  X Window System
is a trademark of the Massachusetts Institute of Technology. I386, 486
and Pentium are trademarks of Intel Corporation.  All other products
or name brands are trademarks of their respective holders.
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A MESSAGE FROM THE TECHNICAL PROGRAM CO-CHAIRS 

 
Welcome to the Second Annual IEEE Communications Society Conference on Sensor and Ad hoc 
Communications and Networks (SECON) in Santa Clara, CA.  SECON 2005 promises to be an exciting 
conference that builds on the successful start of SECON 2004, held for the first time last year.  SECON addresses 
the need to bring together researchers and developers in the area of ad hoc and sensor networks.  Its purpose is to 
provide a forum for members of academia and industry to meet, exchange ideas, and learn about the newest 
research and technology in each of these areas.   

 
The response to the call for papers was very positive. We received a total of 202 papers on various topics as 
solicited in our call for papers. Almost all the papers received at least three reviews and some received as many as 
five reviews if the original three reviews were not consistent in their evaluation. The first phase of the review 
process consisted of three independent reviews for each paper.  Once the reviews were complete, the second 
phase consisted of a discussion on each paper, initiated by that paper’s TPC Lead, between the three reviewers of 
the papers.  The objective of the discussion was to reach an Accept/Discuss/Reject recommendation for the paper 
based on the TPC reviews.  These recommendations guided our discussions during the TPC meeting.  A full-day 
TPC meeting was held in Santa Barbara on June 3, 2005. As a result of this meeting, a total of 55 papers were 
accepted for presentation at the conference, reflecting an acceptance rate of approximately 27%. 

 
The 55 papers have been organized into 24 technical sessions spanning three days of the conference.  Keynote 
talks, panel discussions, demos and poster sessions complete the rest of the program. The Best Student Paper was 
selected by the TPC Co-chairs on the basis of reviews, our evaluation, and input from the TPC members. The 
winner of the Best Paper award will be announced during the opening ceremony of the conference. 

 
We are very thankful to all the TPC members, each of whom reviewed more than 10 papers and served as the 
TPC Lead for four papers. We are also thankful to the external reviewers. The dedicated help and hard work of 
the TPC members and the external reviewers helped us put together a very strong technical program for the 
conference.  We would also like to thank the General Chair, J.J. Garcia-Luna-Aceves, and the Standing 
Committee Chair, Fred Bauer, whose help was invaluable during the planning of the conference.  Finally, we 
would also like to thank the past TPC Co-Chairs, Sung-Ju Lee and Prasant Mohapatra, for their guidance. 

 
We welcome you to Santa Clara, CA, and hope that you will enjoy the conference program and the technical 
discussions with other researchers and practitioners. We also look forward to your continued participation in 
future SECON conferences. 

 
Elizabeth Belding-Royer, Marwan Krunz, and Thyaga Nandagopal 
IEEE SECON 2005 Technical Program Committee Co-Chairs 

 
 



IEEE SECON 2005 Executive Committee 

General Chair:  J.J. Garcia-Luna-Aceves, UC Santa Cruz (UCSC) and Palo Alto Research Center 
(PARC), jj@soe.ucsc.edu  

 

Technical Program  
Co-Chairs:  

Elizabeth Belding-Royer, UC Santa Barbara, ebelding@cs.ucsb.edu  

Marwan Krunz, University of Arizona, krunz@ece.arizona.edu  

Thyaga Nandagopal, Bell Laboratories, thyaga@lucent.com  

 

Panel Co-Chairs:  Srikanth Krishnamurthy, University of California, Riverside, krish@cs.ucr.edu  

Rodrigo Garces, Raytheon, rodrigo_garces@raytheon.com  

 

Tutorial Co-Chairs:  Cedric Westphal, Nokia Research Center, cedric.westphal@nokia.com  

Andreas Savvides, Yale University, andreas.savvides@yale.edu  

 

Poster Chair:  David Gay, Intel Research Berkeley, dgay@intel-research.net 

 

Demo co-chairs:  Bhaskar Krishnamachari, USC, bkrishna@usc.edu 

Fabio Silva, USC/ISI, fabio@isi.edu 

 

Standing Committee 
Chair:  

Fred Bauer, PacketHop, fredbauer@ieee.org 

 

Publicity Chair:  Stefano Basagni, Northeastern University, basagni@ece.neu.edu 

 

Finance Chair:  Bruce Worthman, IEEE Communications Society, Supervisor, Finance and Administration 

 

Local Arrangement 
Chair:  

JoAnne Holliday, Santa Clara Univ., jholliday@scu.edu 

 

Web Chair:  Katia Obraczka, University of California Santa Cruz, katia@soe.ucsc.edu 

 



 
IEEE Communications 
Society  

• Curtis Siller, President  
• Nim Cheung, President Elect  
• Doug Zuckerman, VP, Membership Services  
• Harvey Freeman, VP Technical Activities  
• Shri Goyal, Director, Meetings & Conferences  
• John M. Howell, Executive Director  
• Brian Bigalke, Department Head, Meetings & Conferences  
• Gayle Weisman, Manager, Meetings & Conferences 

(g.weisman@comsoc.org)  

 



IEEE SECON 2005 Program Committee  
 

Kevin Almeroth  UC Santa Barbara  

Nancy Alonistioti  University of Athens 

Suman Banerjee University of Wisconsin  

Sujata Banerjee HP Laboratories 

Stefano Basagni Northeastern University  

Raouf Boutaba  University of Waterloo  

Andrew Campbell Columbia University  

Surendar Chandra  University of Notre Dame  

Sunghyun Choi  Seoul National University  

Chen-Nee Chuah  UC Davis  

Thomas Clausen  INRIA  

Marco Conti IIT Institute - CNR Pisa  

Sajal Das  University of Texas at Arlington  

Tamer ElBatt HRL Laboratories  

Anthony Ephremides University of Maryland, College Park  

Silvia Giordano University of Applied Science - SUPSI  

Emin Gun Sirer  Cornell University  

Richard Han University of Colorado  

Hossam Hassanein Queens University  

Thomas Hou Virginia Tech  

Sridhar Iyer  Indian Institute of Technoilogy  

Anupam Joshi  University of Maryland, Baltimore County  

Rajeev Koodli  Nokia Research Center  

Bhaskar Krishnamachari  University of Southern California  

Lakshman Krishnamurthy  Intel Corporation  

P.R. Kumar  UIUC  

Srisankar Kunniyur  Motorola India  

Tom La Porta  Penn State University  

Sung-Ju Lee  HP Labs  

Mingyan Liu  University of Michigan  

Henrik Lundgren Uppsala University  

Richard Martin  Rutgers University  

Seapahn Megerian  University of Winsconsin, Madison  

Archan Misra  IBM TJ Watson Research Center  

Prasant Mohapatra  UC Davis  

Elena Pagani  University of Milano  

Maria Papadopouli UNC Chapel Hill  



Charles Perkins  Nokia Research Center  

Lili Qiu University of Texas at Austin  

Parmesh Ramanathan University of Wisconsin at Madison  

Srini Ramasubramanian  University of Arizona  

Martin Reisslein Arizona State University  

Ebrahim Saberinia University of Nevada, Las Vegas  

Paolo Santi  CNR  

Saswati Sarkar  University of Pensylvania  

Andreas Savvides  Yale University  

Curt Schurgers  UC San Diego  

Sanjay Shakkottai  University of Texas at Austin  

Rajeev Shorey  IBM Research, New Delhi  

Suresh Singh  Portland State University  

Raghupathy Sivakumar Georgia Institute of Technology  

Krishna Sivalingam  University of Maryland, Baltimore County  

Cedric Westphal Nokia Research Center  

Stephen Wicker  Cornell University  

Guoliang Xue Arizona State University  

Mark Yarvis  Intel Corporation  

Roy Yates Rutgers  

Bulent Yener  Rutgers University  

Junshan Zhang Arizona State University  

Michele Zorzi  Università degli Studi di Padova  

 



 
Corporate Patrons 

 
Silver Patron: 

 
 
 

Bronze Patrons 
 

 

 

 
 
 

 

 

 



SessionsSessions
Session 1:  Architectures and Platforms ❑

Session 2:  Security ❑

Session 3:  Resource Management and Network Planning ❑

Session 4:  Routing and Forwarding I ❑

Session 5:  Applications and Experimental Designs ❑

Session 6:  Routing and Forwarding II ❑

Session 7:  Topology Control ❑

Session 8:  Network Modeling and Analysis ❑

Session 9:  Scheduling ❑

Session 10:  Energy Management ❑

Session 11:  MAC and Spectrum Allocation ❑

Session 12:  Routing and Forwarding III ❑

Session 13:  Localization and Ranging ❑

Session 14:  Network Coverage ❑

Click on a title for a list of papers.
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Session 1:  Architectures and Platforms 

RISE - Co-S: High Performance Sensor Storage and Co-
Processing Architecture 
A. Banerjee, A. Mitra, W. Najjar, D. Zeinalipour-Yazti, V. Kalogeraki and D. Gunopulos

A Scalable Framework for Distributed Time Synchronization 
in Multi-Hop Sensor Networks 
Ossama Younis and Sonia Fahmy

A Layered Architecture for Delay Sensitive Sensor Networks 
Dan Wang, Yan Long and Funda Ergun

Designing New Architectures and Protocols for Wireless 
Sensor Networks: A Perspective 
Mukundan Venkataraman, Kartik Muralidharan and Puneet Gupta

Click on a title to see the paper.
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Session 2:  Security 

Group Key Distribution via Local Collaboration in Wireless 
Sensor Networks 
Anuj Chadha, Yonghe Liu and Sajal K. Das

Secure Cooperative Mobile Ad Hoc Networks Against 
Injecting Traffic Attacks 
Wei Yu and K. J. Ray Liu

Stimulating Cooperation and Defending Against Attacks in 
Self-Organized Mobile Ad Hoc Networks 
Wei Yu and K. J. Ray Liu

Efficient Hierarchical Key Generation and Key Diffusion for 
Sensor Networks 
Mohamed Shehab, Elisa Bertino and Arif Ghafoor

Click on a title to see the paper.
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Session 3:  Resource Management and Network 
Planning 

Price/Utility-Based Optimized Resource Allocation in 
Wireless Ad Hoc Networks 
Calin Curescu and Simin Nadjm-Tehrani

Congestion Control in Multi-Hop Wireless Networks 
Kun Tan, Qian Zhang, Feng Jiang and Xuemin Shen

Proactive Address Autoconfiguration and Prefix Continuity in 
IPv6 Hybrid Ad Hoc Networks 
Christophe Jelger and Thomas Noel

Key Pre-Distribution in Wireless Sensor Networks Using 
Multivariate Polynomials 
Farshid Delgosha and Faramarz Fekri

Click on a title to see the paper.
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Session 4:  Routing and Forwarding I 

On the Forwarding Area of Contention-Based Geographic 
Forwarding for Ad Hoc and Sensor Networks 
Dazhi Chen, Jing Deng and Pramod K. Varshney

Channel-Adaptive Relaying in Mobile Ad Hoc Networks with 
Fading 
Michael R. Souryal and Nader Moayeri

Improving the Performability of Data Transfer in Mobile Ad 
Hoc Networks 
Marco Conti, Enrico Gregori and Gaia Maselli

Routing in a Highly Dynamic Topology 
Yashar Ganjali and Nick McKeown

Click on a title to see the paper.
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Session 5:  Applications and Experimental 
Designs 

Redundant Reader Elimination in RFID Systems 
Bogdan Carbunar, Murali Krishna Ramanathan, Mehmet Koyutürk, Christoph Hoffmann and 
Ananth Grama

Streaming Versus Batch Processing of Sensor Data in a 
Hazardous Weather Detection System 
Mark Sims, Jim Kurose and Victor Lesser

Switching Kalman Filters for Prediction and Tracking in an 
Adaptive Meteorological Sensing Network 
Victoria Manfredi, Sridhar Mahadevan and Jim Kurose

Embedding Intelligent Sensor Signal Change Detection into 
Sensor Network Protocols 
Leon Reznik, Gregory Von Pless and Tayeb Al Karim

Click on a title to see the paper.
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Session 6:  Routing and Forwarding II 

Expected Data Rate: An Accurate High-Throughput Path 
Metric for Multi-Hop Wireless Routing 
Jun Cheol Park and Sneha Kumar Kasera

A Local Metric for Geographic Routing with Power Control in 
Wireless Networks 
Chih-ping Li, Wei-jen Hsu, Bhaskar Krishnamachari and Ahmed Helmy

Scalable Routing for Networked Sensors and Actuators 
Thomas Fuhrmann

Blacklist-Aided Forwarding in Static Multihop Wireless 
Networks 
Srihari Nelakuditi, Sanghwan Lee, Yinzhe Yu, Junling Wang, Zifei Zhong, Guor-Huar Lu and 
Zhi-Li Zhang

Click on a title to see the paper.
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Session 7:  Topology Control 

Interference-Aware Topology Control for Wireless Sensor 
Networks 
Xiang-Yang Li, Kousha Moaveni-Nejad, Wen-Zhan Song and Wei-Zhao Wang

Optimal Placement of Nodes in Large Sensor Networks 
Under a General Physical Layer Model 
S. Toumpis and G. A. Gupta

Mesh Topology Construction for Interconnected Wireless 
LANs 
Huei-jiun Ju and Izhak Rubin

Prolonging Sensor Network Lifetime with Energy 
Provisioning and Relay Node Placement 
Y. Thomas Hou, Yi Shi, Hanif D. Sherali and Scott F. Midkiff

Click on a title to see the paper.
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Session 8:  Network Modeling and Analysis 

Modeling Spatially-Correlated Data of Sensor Networks with 
Irregular Topologies 
Apoorva Jindal and Konstantinos Psounis

The Impact of the Topology on the Throughput of 
Interference-Limited Sensor Networks with Rayleigh Fading 
Xiaowen Liu and Martin Haenggi

Practical Limits on Achievable Energy Improvements and 
Useable Delay Tolerance in Correlation Aware Data 
Gathering in Wireless Sensor Networks 
Yujie Zhu, Karthikeyan Sundaresan and Raghupathy Sivakumar

Modelling the Effect of Network Parameters on Delay in 
Wireless Ad-Hoc Networks 
Srisankar S. Kunniyur and Srihari Narasimhan

Click on a title to see the paper.
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Session 9:  Scheduling 

Collaborative Two-Level Task Scheduling for Wireless 
Sensor Nodes with Multiple Sensing Units 
H. Ozgur Sanli, Rajesh Poornachandran and Hasan Cam

Energy Efficient Joint Scheduling and Power Control for 
Wireless Sensor Networks 
Gang Lu and Bhaskar Krishnamachari

A Dynamic Clustering and Scheduling Approach to Energy 
Saving in Data Collection from Wireless Sensor Networks 
Chong Liu, Kui Wu and Jian Pei

Partitioning Based Mobile Element Scheduling in Wireless 
Sensor Networks 
Yaoyao Gu, Doruk Bozdag, Eylem Ekici, Füsun Özgüner and Chang-Gun Lee

Click on a title to see the paper.
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Session 10:  Energy Management 

EASE: An Energy-Efficient In-Network Storage Scheme for 
Object Tracking in Sensor Networks 
Jianliang Xu, Xueyan Tang and Wang-Chien Lee

Evolutionary Energy Management and Design of Wireless 
Sensor Networks 
Konstantinos P. Ferentinos and Theodore A. Tsiligiridis

Power Management in Delay Tolerant Networks: A 
Framework and Knowledge-Based Mechanisms 
Hyewon Jun, Mostafa H. Ammar and Ellen W. Zegura

Battery Discharge Characteristics of Wireless Sensor 
Nodes: An Experimental Analysis 
Chulsung Park, Kanishka Lahiri and Anand Raghunathan

Click on a title to see the paper.
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Session 11:  MAC and Spectrum Allocation 

SoftMAC: Layer 2.5 MAC for VoIP Support in Multi-Hop 
Wireless Networks 
Haitao Wu, Xin Wang, Yunxin Liu, Qian Zhang and Zhi-Li Zhang

A Multiband MAC Protocol for Impulse-Based UWB Ad Hoc 
Networks 
Ioannis Broustis, Srikanth Krishnamurthy, Michalis Faloutsos, Mart Molle and Jeffrey Foerster

Optimization Models for Fixed Channel Assignment in 
Wireless Mesh Networks with Multiple Radios 
Arindam K. Das, Hamed M. K. Alazemi, Rajiv Vijayakumar and Sumit Roy

Distributed Spectrum Allocation via Local Bargaining 
Lili Cao and Haitao Zheng

Click on a title to see the paper.
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Session 12:  Routing and Forwarding III 

Variable-Resolution Information Dissemination 
Arpita Ghosh, Dan Greene, Qingfeng Huang and Juan Liu

Attribute-Based Clustering for Information Dissemination in 
Wireless Sensor Networks 
Ke Wang, Salma Abu Ayyash, Thomas D. C. Little and Prithwish Basu

Reliable Broadcast in ZigBee Networks 
Gang Ding, Zafer Sahinoglu, Bharat Bhargava, Philip Orlik and Jinyun Zhang

Securing MAODV: Attacks and Countermeasures 
Sankardas Roy, V. Gopala Addada, Sanjeev Setia and Sushil Jajodia

Click on a title to see the paper.
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Session 13:  Localization and Ranging 

Precise Localization in Coarse-Grained Localization 
Algorithms Through Local Learning 
Ralf Salomon

Robust, Probabilistic, Constraint-Based Localization for 
Wireless Sensor Networks 
Rong Peng and Mihail L. Sichitiu

Acquiring Medium Models for Sensing Performance 
Estimation 
Aman Kansal, James Carwana, William J. Kaiser and Mani B. Srivastava

Click on a title to see the paper.
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Session 14:  Network Coverage 

Outage Probabilities in Poisson and Clumped Poisson-
Distributed Hybrid Ad-Hoc Networks 
Sayandev Mukherjee and Dan Avidor

Relay Node Deployment Strategies in Heterogeneous 
Wireless Sensor Networks: Multiple-Hop Communication 
Case 
Kenan Xu, Hossam Hassanein and Glen Takahara

Energy-Efficient Sensor Network Design Subject to 
Complete Coverage and Discrimination Constraints 
Frank Y. S. Lin and P. L. Chiu

Fault Tolerant Connected Sensor Cover with Variable 
Sensing and Transmission Ranges 
Zongheng Zhou, Samir Das and Himanshu Gupta

Click on a title to see the paper.
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